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Introduction 
This guide is intended to help Scanvec Amiable users to 
output accurate and high-quality contour cut jobs on the 
various cutters and hybrid devices that our software supports. 

Hybrid Output 
There are a number of output devices that can both print an 
image and cut a contour on it. These are known as hybrid 
devices. 

In general, when a job with both printed and cut elements is 
sent to a hybrid device, the printed elements are output first, 
and then the contour is cut immediately afterwards as part of 
the same action. 

Flexi Hybrid Output Workflow 
The steps needed to output contour cut jobs from a hybrid 
device in Flexi are: 

1. Creating setups for your output devices. 

2. Designing the job. 

3. Setting job properties using either the RIP & Print dialog. 

4. Sending the job to Production Manager. 

5. Outputting the job from Production Manager. 

PhotoPRINT Hybrid Output Workflow 
The steps needed to output hybrid jobs in PhotoPRINT are: 

1. Creating setups for your output devices. 

2. Adding the job. 

3. Setting job properties. 

4. Sending the job to the output device. 

Virtual Hybrid Output 
Virtual hybrid output produces results similar to hybrid output, 
using a separate printer and cutter. The job is first printed out 
on a printer, then loaded into a cutter and cut. 

When a virtual hybrid job is output, it generates both a printed 
job and a cut job. The printed job is printed immediately. The 
cut job is held in the cutter queue to give the user time to print 
the job and load the printed output into the cutter. Once the 
printed output is loaded into the cutter, the user then sends the 
cut job manually. 

Flexi Virtual Hybrid Output Workflow 
The steps needed to output contour cut jobs from a virtual 
hybrid setup in Flexi are: 

1. Creating setups for your output devices. 

2. Designing the job. 

3. Setting job properties using the RIP & Print dialog. 

4. Sending the job to Production Manager. 

5. Outputting the printed job from Production Manager. 

6. Loading the printed output into the cutter. 

7. Outputting the cut job from Production Manager 

PhotoPRINT Virtual Hybrid Output Workflow 
The steps needed to output contour cut jobs from a virtual 
hybrid setup in PhotoPRINT are: 

1. Creating setups for your output devices. 

2. Adding the job. 

3. Setting job properties. 

4. Sending the job to Production Manager. 

5. Sending the printed job to the printer. 

6. Loading the printed output into the cutter. 

7. Sending the cut job to the cutter. 
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Creating Output Device Setups 
Setups provide the link between the software and your output 
devices. Each setup contains the following information: 

• The type of output device being used. 

• The method used to communicate with the device. 

• Details of how incoming print jobs will be processed. 

• The default job properties that will be applied to a new job. 

Production Manager and PhotoPRINT Server allow for multiple 
setups to be in use at the same time. It is possible to have 
more than one setup for each output device. This is useful 
because it allows you to configure each setup for a different 
purpose. You can have one setup for printing proofs, and 
another for final output, for instance. You can also have 
different setups for different output media. 

Adding New Setups To Production Manager or 
PhotoPRINT 

To add new setups: 

1. From the Setup menu, select Change Setup or Add 
Setup. 

 
2. Select the type of device being set up. 

3. Select the Manufacturer and Model Name of the output 
device from the list. 

4. Click Next. 

 
5. Edit the Setup name of the device. 

6. Click Next. 
7. Select the Port the output device uses for communication. 

If necessary, edit the communications settings for the 
chosen port. 

 If TCP/IP is available for the network output device, use TCP/IP. If not, you 
should choose LPR or FTP. 

8. Click Finish. 
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Designing Contour Cut Jobs in Flexi 
Contour cut jobs contain both a printed element, and one or 
more contour cuts. 

Contour cut jobs are output using the RIP & Print dialog. When 
the RIP & Print dialog is used, all design elements are 
automatically converted to printed graphics, except for those 
elements that were created specifically as contour cuts. Those 
contour cuts will remain as cut elements, and will be cut into 
the printed design when output. 

There are two main ways in which contour cuts can be added 
to jobs: 

• Objects in a job can be converted into contour cut paths. 

• The Contour Cut effect can be used to trace a contour 
around one or more objects. 

Converting Vector Objects to Contour Cuts 
Vector objects can be transformed into contour cuts. This 
allows you create a contour cut of any needed shape. 

 
A fan shape converted into a contour cut 

To convert a vector object into a contour cut: 

1. Select the object. 

2. From the Arrange menu, point to Contour Cut and then 
select Make Contour Cut. 

The object’s outline color will change to a light gray, indicating 
that it has been converted to a contour cut. Even after being 
converted to a contour cut, the object will have its original 
attributes. 

Converting Contour Cuts Back Into Vector Objects 
To convert the contour cut back to a vector object: 

1. Select the contour cut. 

2. From the Arrange menu, point to Contour Cut and then 
select Release Contour Cut. 

Using the Contour Cut Effect 
The Contour Cut effect allows you to trace a contour cut 
around one or more objects in your design.  

   
To trace a contour cut around one or more objects using the 
Contour Cut effect: 

1. Select the objects. 

2. From the Effect menu, select Contour Cut. 
3. Adjust the values in DesignCentral. 

 Select the type between Contour, Rectangle and 
Ellipse. 

 
Contour mode Rectangle 

mode 

 
Ellipse mode 

Offset distance from object to cutting line. The value 
can be negative, allowing you to make a contour cut 
line inside the design, in order to prevent 
misalignments in printing and cutting process. This 
field is only available for Contour mode. 

Width of the contour shape (Ellipse or Rectangle). 
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 Height of the contour shape (Ellipse or Rectangle). 

Proportional Check this value to assure that the cutting line will be 
resized proportionally when you change its height or 
width. This option is not available for Contour mode. 

With Holes When this option is checked, all holes in the selected 
objects will have an inner contour cut line. This option 
is not available for Ellipse or Rectangle mode. 

 

Contour with Holes Contour Without Holes 

 Joint Type specifies how the corners are contoured. 

4. Click Apply.  

Tracing Bitmaps with the Contour Cut Effect 
To allow the Contour Cut effect to trace the outline of an object 
in a bitmap, make the background of the image transparent 
using the Make Transparent function. Otherwise, the Contour 
Cut effect will only be able to trace around the outside of the 
bitmap. 

  
Opaque Background Transparent Background 
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 Outputting Contour Cut Jobs in Flexi 
There are two stages to outputting jobs in Flexi. First, the job is 
sent to Production Manager using the RIP and Print dialog. 
The job is then sent to the output device from Production 
manager. 

Sending Contour Cut Jobs to Production 
Manager 

To begin the output process, select the objects you want to 
output and open the RIP and Print dialog in one of the 
following ways: 

• From the File menu, select RIP and Print. 

• Click on the RIP and Print button in the toolbar. 

If no objects are selected, all objects in the design will be 
output. 

 

Selecting the Printer 
Select the printer you want to use from the list in the top left 
corner of the dialog. 

Selecting the Cutter for Hybrid Output 
If you are printing the job to a hybrid device, the hybrid device 
will automatically be selected as the cutting device as well. 

Selecting the Cutter for Virtual Hybrid Output 
To select the cutter this will be used to cut the contours in a 
virtual hybrid job: 

1. Select the Advanced tab of the RIP and Print dialog. 

2. Click on the Contour button. 

 
3. Select the cutter from the list in the upper left corner of the 

dialog. 

4. Set Registration mark to the desired registration mark. 

5. Click Done. 

Sending the Job to Production Manager 
Click the Send button to send the job to Production Manager. 
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Outputting Contour Cut Jobs from Production 
Manager 

There are slightly different procedures to follow when 
outputting a hybrid output job vs. a virtual hybrid job. 

Outputting a Hybrid Output Job 
To output a hybrid output job, use one of the following 
methods: 

• Select the job and from the File menu, select Send. 

• Right-click the job and select Send from the context menu. 

The job will be printed, then contour cut immediately 
afterwards as part of the same operation. 

Outputting a Virtual Hybrid Job 
When a job containing contour cuts is RIPed as a virtual hybrid 
job, both a print job and a separate cutting job are generated. 
The print job will be output automatically, but the contour cut 
job must be sent to the cutter manually. This is done to give 
the user the time to get the output out of the printer and load it 
into the cutter. 

To output the contour cut of a virtual hybrid job on a Gerber 
cutter: 

1. Output the printed job. 

2. Load the printed output into the cutter. 

3. Send the cut job to the cutter using one of the following 
methods: 

• Select the job and from the File menu, select Send. 

• Right-click the job and select Send from the context 
menu. 

 
4. Use the front panel controls on the cutter to position the 

head of the cutting device over the registration mark. 

5. Press the RUN/START JOB button on the cutting device 
(or Run Single, etc.). 

6. Click OK in the software. 
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Outputting Contour Cut Jobs in 
PhotoPRINT 

Setting Up a Job for Contour Cutting 
In order for a contour to be cut when a job is output through a 
hybrid device or virtual hybrid, the following must be true: 

• The job must be vector-based. 

• The contours to be cut must be assigned a stroke with a 
custom color named CutContour. 

For specific details on setting up jobs within a given 
application, please consult the Client Application Print Guide. 

Hybrid Device Output 
To output a job that includes a contour cut through a hybrid 
device: 

1. Set up the job as described above. 

2. Add the job to the setup for a hybrid device. 

3. Open the Job Properties dialog for the job and make sure 
the Send setting in the Workflow tab is set to Print and 
contour. 

4. RIP and print the job normally. 

The contour will be cut after the job is printed. 

Virtual Hybrid Output 
The software allows you to use a printer and a cutting device 
together to produce the same results as a hybrid printer/cutter. 

Virtual Hybrid Output on a Cutter with Automatic 
Alignment 

To output a job using virtual hybrid output, and an 
automatically aligned cutter: 

1. Set up the job as described above. 

2. Add the job to the setup for the printer you want to use as 
part of the virtual hybrid. 

3. Open the Job Properties dialog for the job and select the 
Workflow tab. 

4. Check the Send cut job box and select the cutter you 
want to use as the second half of your virtual hybrid. 

 When you select the cutter in the Workflow tab, the default registration 
marks for that cutter are automatically added to the job. 

5. Click OK to close the Job Properties dialog. 

6. RIP and print the job. 

 Once you RIP and print the job, the cut portion of the job automatically 
appears in the Hold Queue. 

7. Remove the output medium from the printer and load it into 
the cutter. 

8. Output the cut job in the Hold Queue as you would a 
normal print job. 

 
9. Align the cutting head over the first automatic registration 

mark (lower right if not marked) using the controls on the 
front panel of the cutter. 

10. Click OK to cut the contour. 

Virtual Hybrid Output on a Manually Aligned Cutter 
To output a job using virtual hybrid output, and a manually 
aligned cutter: 

1. Set up the job as described above. 

2. Add the job to the setup for the printer you want to use as 
part of the virtual hybrid. 

3. Open the Job Properties dialog for the job and select the 
Workflow tab. 
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4. Check the Send cut job box and select the cutter you 
want to use as the second half of your virtual hybrid. 

 When you select the cutter in the Workflow tab, the default registration 
marks for that cutter are automatically added to the job. 

5. Click OK to close the Job Properties dialog. 

6. RIP and print the job. 

 Once you RIP and print the job, the cut portion of the job automatically 
appears in the Hold Queue. 

7. Remove the output medium from the printer and load it into 
the cutter. Make sure the output medium is straight, and 
align the registration marks to the origin for the cutter. 

8. Output the cut job in the Hold Queue as you would a 
normal print job. 

 
9. Select the method to be used to position the cut head over 

the registration marks and click OK. 

Interactive 
alignment 

You will position the cut head over the registration 
marks using software controls. 

Digitize 
alignment 

You will position the cut head over the registration 
marks using the controls on the face of the cutter. 

 This option is only available when a bi-directional 
communications protocol such as serial or USB is used. 

a. To indicate the position of the registration marks using 
Interactive alignment: 

 

i. Use the arrow buttons to position the head of the 
cutting device over registration mark 1 and click 
OK. 

ii. Repeat for all additional registration marks. 

b. To indicate the position of the registration marks using 
Digital alignment: 

 
i. Use the front panel controls on the cutter to position 

the head of the cutting device over registration 
mark 1. Press Enter on the cutting device and click 
OK. 

ii. Repeat for all additional registration marks. 

 
10. Make sure the knife is loaded into the cutter, then click OK 

to cut the contour portion of the design. 
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Appendix A: Notes on Specific Output 
Devices 

GCC SignPal Jaguar III 

Cutting Contours Using the GCC Accu-Aligning 
System 

To cut a contour using GCC AAS registration marks: 

1. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

2. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

3. Set Registration Mark to GCC. 

4. Print the job and load the printed output into the cutter. 

5. Send the cut job. 

 

 
6. On cutter AFTER sending job: 

a. Load media and lower the lever. 

b. Press the down arrow key to select "Edge" detection. 

c. Press ON/OFF LINE to take the cutter offline. 

d. Press CUT TEST. 

e. Press the left arrow key to select "AAS Function. 

f. Press ENTER. 

g. Press ENTER again to select "AAS-3-points" detection. 

 
h. Use the arrow keys to set the origin on the first (or 

lower right) mark then press ENTER. 

i. If unsuccessful, you must unload the media then begin 
again at step a. 

 If successful, the sensor will detect 3 of the four marks and return to 
the origin. 

j. Click Yes in the software. The job will now cut. 

AAS Offset Calibration 
In order for the contour cut to be accurate, we found it 
necessary to adjust the X and Y values of the "AAS Offset". To 
get to the offset settings on the cutter, follow this procedure: 

1. Press the ON/OFF Line key to take the cutter offline. 

2. Press the MISC key. 

3. Press the left arrow key twice to get to the AAS Offset 
menu. 

4. Press ENTER to accept. 

5. To adjust the offset, use the left and right arrow keys to 
select between the X: and Y: settings. Use the up and 
down arrow keys to adjust the values. 
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 Positive X values will cause the contour to shift down from its current 
position. Positive Y values will cause the contour to shift to the right of its 
current position. Of course, negative values shift in the opposite directions 
as described. 

6. Press ENTER to accept changes or press ON/OFF LINE 
to abort. 
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Gerber GS15, HS-15, HS-15 Plus, HS-750, HS-750 
Plus 

To cut a contour using a Gerber cutter: 

1. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

2. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

3. Set Registration Mark to Gerber Edge Center.  

4. Print the job and load the printed output into the cutter. 

5. Send the cut job. 

 

 
6. Use the front panel controls on the cutter to position the 

head of the cutting device over the Gerber registration 
mark. 

 

7. Press the RUN/START JOB button on the cutting device 
(or Run Single, etc.). 

8. Click on OK in the software. 

The cutter will detect the registration mark, and then cut the 
contours. 
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Graphtec 5100/5100A 
The 5100 series cutters are able to automatically align 
themselves using registration marks. Two different types of 
registration marks are supported: 

  
Type 1 Type 2 

 

When using the Graphtec registration marks, there must be 
the same number of copies in each row. If need be, add extra 
copies to fill up the last row.  

 

 

 
Good  Bad 

 

Graphtec Type 1 & Type 2 Marks (Manual 
Alignment) 

To cut a contour into a job using Graphtec Type 1 or 2 marks: 

9. Make sure the connection to the cutter is a serial cable. 
USB connections are only supported for the automatic 
Type 1 & Type 2 marks. 

10. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

11. Print the job and load the printed output into the cutter. 

12. Set the mark type in the cutter 

13. Send the cut job. 

 

 
14. Using the controls on the cutter, align the knife with the 

lower right registration mark and press the ENTER button 
on the cutter. 

15. Click on OK in the software. 

 
16. Click Yes. 

Graphtec Type 1 & Type 2 Automatic Marks 
To cut an outline around a job using Type 1 or Type 2 
automatic marks: 

17. If you are connecting to the cutter via USB, install the 
Graphtec USB driver. 

18. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

19. Print the job and load the printed output into the cutter. 

20. Send the cut job. 
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21. Place the knife within the lower-right mark and press the 
Origin button on the cutter. 

    

 
22. Click OK in the software. 

The cutter will automatically detect all of the remaining marks 
and cut them individually. 
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Graphtec FC7000 
The 7000 series cutters are able to automatically align 
themselves using registration marks. Two different types of 
registration marks are supported: 

  
Type 1 Type 2 

 

When using the Graphtec registration marks, there must be 
the same number of copies in each row. If need be, add extra 
copies to fill up the last row.  

 

 

 
Good  Bad 

 

Graphtec Type 1 & Type 2 Marks (Manual 
Alignment) 

To cut a contour into a job using Graphtec Type 1 or 2 marks: 

1. Make sure the connection to the cutter is a serial cable. 
USB connections are only supported for the automatic 
Type 1 & Type 2 marks. 

2. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

3. Print the job and load the printed output into the cutter. 

4. Set the mark type in the cutter 

5. Send the cut job. 

 

 
6. Using the controls on the cutter, align the knife with the 

lower right registration mark and press the ENTER button 
on the cutter. 

7. Click on OK in the software. 

 
8. Click Yes. 

Graphtec Type 1 & Type 2 Automatic Marks 
To cut an outline around a job using Type 1 or Type 2 
automatic marks: 

1. If you are connecting to the cutter via USB, install the 
Graphtec USB driver. 

2. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

3. Print the job and load the printed output into the cutter. 

4. Send the cut job. 

 
5. Place the knife within the lower-right mark and press the 

Origin button on the cutter. 
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6. Click OK in the software. 

The cutter will automatically detect all of the remaining marks 
and cut them individually. 
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Ioline SmarTrac Contour Cutters 
To cut a contour using Ioline registration marks: 

1. Print the job and load the printed output into the cutter. 

2. Send the cut job. 

 

 
3. Align the sensor light over the first mark (the lower right 

mark), press the Set Origin button on the cutter, and then 
click OK in the software. 

 
 Dial the cutting speed down when aligning on the marks to make it easy to 

control. Dial the speed back up again to cut. 

The cutter will automatically find the other registration 
marks. 

 
4. Click Yes to cut the contour. 

If the cutter does not automatically find the registration marks, 
click No to abort the job. 
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Mimaki CG-60 EX, CG-100 EX, CG-130 EX Cutters 
To cut a contour using the Mimaki CG-60 EX, CG-100 EX, or 
CG-130 EX cutters: 

1. If you are connecting to your cutter via USB, install the 
Mimaki USB driver. 

2. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

3. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

4. Set Registration Mark to Mimaki EX. 

5. Print the job and load the printed output into the cutter. 

6. Send the cut job. 

 

 
7. Align the cutting head over the first automatic registration 

mark (lower right if not marked) using the controls on the 
front panel of the cutter. 

 
8. Click OK in the software. 
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Mimaki CG-75 FX, CG-130 FX, CG-160 FX Cutters 
To cut a contour using the Mimaki CG-75 FX, CG-130 FX, or 
CG-160 FX cutters: 

1. If you are connecting to your cutter via USB, install the 
Mimaki USB driver. 

2. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

3. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

4. Set Registration Mark to Mimaki Type 1. 

5. Print the job and load the printed output into the cutter. 

6. Send the cut job. 

 
7. Configure the cutter: 

 
a. If the LCD on the cutter reads REMOTE, press the 

REMOTE button on the cutter to switch it to local 
operation. 

b. Turn off automatic mark detection: 

i. Press the FUNCTION button on the cutter. 

ii. Use the up and down arrow buttons to select Set 
Up. 

SET UP      <ENT> 

iii. Press the ENTER/HOLD button. 

iv. Use the up and down arrow buttons to select 
MARK DETECT. 

MARK DETECT <ENT> 

v. Press the ENTER/HOLD button. 

vi. Use the up and down arrow buttons to select OFF. 

MARK DETECT: OFF 

vii. Press the ENTER/HOLD button. 

viii. Press END to back out of the menus. 

c. Set the origin at the intersection of the lower right mark: 

 
i. Use the arrow keys to move the cutter head over 

the corner of the lower right registration mark. 

ii. Press the ENTER/HOLD button. 

d. Set the cutter to Remote mode. Pressing the REMOTE 
button on the cutter toggles Remote mode on and off. 

8. Click OK in the software. 
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Using One Set of Registration Marks for Multiple 
Copies of a Job 

When printing multiple copies of a job, the default is to have a 
separate set of registration marks for each copy. However, for 
the Mimaki CG-FX cutters, it is possible to use just one set of 
registration marks for the entire set of jobs. 

   
Using a single set of registration marks for multiple jobs allows 
the jobs to be cut in less time, because the cutter has to 
process far fewer registration marks. It also saves material that 
would otherwise be taken up by the extra registration marks. 
However, it sacrifices some precision in cutting, because the 
cutting head does not get realigned for each copy. 

To set the software to use one set of registration marks for the 
entire set of jobs, check One set for all copies in the Contour 
Options dialog under Registration Mark. 
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Mutoh SC-850D/1400D 

Cutting Jobs Using Automatic Mark Detection 
To cut a contour using the Mutoh SC-850D or 1400D cutters: 

1. If you will be running the Mutoh cutter off of USB, install 
the Mutoh USB Drivers.  

2. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

3. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

4. Set Registration Mark to Mutoh. 

5. Print the job, and then advance the media before cutting. 
There needs to be at least four inches of blank space 
above the top of the Mutoh registration mark. 

6. Load the printed output into the cutter. 

7. Send the cut job. 

The cutter will automatically detect the Mutoh registration mark 
and cut the contours. 

Cutting Jobs using Mutoh Cut Server 
Mutoh Cut Server is an application that cuts contours onto 
printed materials using Mutoh cutters.  

Applications can output jobs to Cut Server by saving each job 
as a .plt file in a directory that Cut Server monitors. CutServer 
can then cut the jobs, using automatic registration marks to 
align the cuts with the printed material. 

If a printed job is loaded into the cutter backwards, Cut Server 
will detect it, and will automatically rotate the cut job 180 
degrees to match. 

To cut a contour using Mutoh Cut Server, do the following: 

1. If you will be running the Mutoh cutter off of USB, install 
the Mutoh USB Drivers.  

2. Install the Mutoh Cut Server application. 

3. Create a folder on your C: drive named MutohJobs. 

Ex: 
C:\Program Files\FlexiSIGN-PRO 7.6v1\Jobs\Mutoh\SC850D\MutohJobs 

4. In Mutoh Cut Server, set the directory to the MutohJobs 
directory created earlier. 

5. Launch PhotoPRINT Server or Production Manager. 

6. Add a setup for your printer. 

7. Add a setup for the Mutoh Barcode Cutter. Set the Cutter 
to use the File port, and set the Default location to the 
MutohJobs directory. 

8. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

9. Position the job at least 4 inches from the bottom of the 
media, and at least 4 inches from the right edge. 

10. Set Registration Mark to Mutoh Type 2 or Mutoh 
Multiple Segments. 

 Selecting Mutoh Multiple Segments automatically sets the number of 
segments so that no segment is larger than 50cm. To use only one 
segment, select Mutoh Type 2.  

11. Send your print job. 

12. Load the printed output into the Mutoh cutter. 

13. Send your cut job. 

14. Save the job file using the default name (You have to do 
this because the name of the file includes the barcode 
number). 

15. Start Mutoh Cut Server. 
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16. Select the .plt job file and click Send.  

Mark detection takes about 30 seconds before cutting. 

Printing Multiple Jobs on a Single Piece of Media 
Using Cut Server, you can output more than one job on a 
single sheet or roll of media. 

In your design application, simply output the printed portions of 
the jobs one after another. The order you print the jobs in does 
not matter. The printed portion of each job will be marked with 
a barcode that will identify which contour cut job Cut Server 
should use with that design.  

Once the print jobs have been output, you can then output all 
the cut jobs from your design application, sending them to Cut 
Server. Again, it does not matter which order you output the 
cut jobs in. 

Next, load the printed output into the cutter and output the cut 
jobs from Cut Server. As each cut job is output, Cut Server will 
scan the barcodes the printed jobs until it finds the one that 
matches the cut job. Cut Server will then cut the contour onto 
that printed job. 
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Roland CAMMJET and SOLJET Devices 
 Applies to: Roland CAMMJET CJ-400/500, CAMMJET PRO II 540, SOLJET SC-

500, SOLJET PRO II SC-540, SOLJET PRO II EX SC-540 EX, SOLJET PRO II 
V SC-545 EX 

Printing a Laminated Job 
If you want to print a job, laminate it, and contour cut it later, 
the CAMMJET and SOLJET automatic alignment function 
makes it possible to align the printing and cutting positions. 

1. Add a setup for the device to PhotoPRINT or Production 
Manager. 

2. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

3. Set Send to Print job only. 

4. Set Registration mark to Roland SolJet/CAMMJet. 

 If you are using PhotoPRINT, the software automatically adds the 
appropriate registration marks to the job when you select the output device 
in the Workflow tab of Job Properties. 

5. Click Send. The print out should look similar to the image 
shown below with black circles and crop marks added by 
the printer. 

 
6. Remove the media from the printer and laminate it. 

7. Reload the media in the printer. 

8. Set Send to Contour job only. 

9. Click Send and the device will automatically detect the 
alignment marks and cut the contour. 

Using a CAMMJET or SOLJET as a Virtual Hybrid 
To print a job on another device and use a CAMMJET or 
SOLJET as a cutter: 

1. When printing the job: 

a. Select the CAMMJET or SOLJET as the cutter. 

b. Set Registration mark to Roland SolJet/CAMMJet. 

 If you are using PhotoPRINT, the software automatically adds the 
appropriate registration marks to the job when you select the output 
device in the Workflow tab of Job Properties. 

c. Set Send to Print job only. 

2. Print the job. The print out should look similar to the image 
below, with black circles and crop marks added by the 
printer. 

 
3. Remove the media from the printer. 

4. Load the media in the CAMMJET or SOLJET. 

5. Set Send to Contour job only. 

6. Click Send. The device will automatically detect the 
alignment marks and cut the contour. 
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Roland CAMMJET PRO 1 GX 24, GX 300, GX 400, 
GX 500 

Cutting a Laminated Job 
The CAMMJET GX series cutters default to the left side of the 
device. Each device has a specific width limitation. Consult 
your device manual for more information. 

To print a job on another device and use a CAMMJET GX as a 
cutter: 

1. When printing the job: 

a. Select the appropriate CAMMJET GX as the cutter. 

b. Set Registration mark to Roland CAMMJET GX 
series number. 

 If you are using PhotoPRINT, the software automatically adds the 
appropriate registration marks to the job when you select the output 
device in the Workflow tab of Job Properties. 

c. Set Send to Print job only. 

2. Print the job. The print out should look similar to the image 
below, with black circles and crop marks added by the 
printer. 

 
3. Remove the media from the printer. 

4. Use the sheet direction arrows to load the media in the 
CAMMJET GX 300. The arrows should point toward the 
cutter when inserted from the front. 

5. On the device’s front panel, set the rotation degree to zero 
(0). See your device manual for instructions. 

6. Use the arrow keys on the device’s front panel to move the 
cutter’s sensor head over a registration mark. 

7. Set Send Mode to Contour Only. 

8. Click Send. The device will automatically detect the 
alignment marks and cut the contour. 

Roland VersaCAMM SP-300/SP-300V/SP-540V 

Printing a Laminated Job 
When you want to print a job, remove it from the printer (for 
lamination or the like), then reload the media and cut the job, 
the SP300 automatic alignment function makes it possible to 
align the printing and cutting positions. 

To cut a contour using the Roland AutoSense Crop Marks: 

1. Be sure you have installed the USB driver that was 
supplied on the “SP300 Driver Disk Printer Driver 
Installation” CD. 

2. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

a. Set Port to USB_Printer_0. 

3. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

4. Position the job at least 4 inches from the bottom of the 
media, and at least 4 inches from the right edge. 

5. Set Registration Mark to Roland VersaCAMM. 

6. Set Send to Print job only. 
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7. Send your print job. 

a. After the printing, be sure to advance AT LEAST 6” 
before cutting the sheet. 

b. Allow the graphic time to dry and finish with laminate, 
overcoat, etc. 

 
8. Reload the output into the printer: 

a. Replace the graphic into the printer, aligning the crop 
marks with the cutter protection strip. 

b. Place the pinch rollers outside of the graphic area. 

c. Close the handle to lock the pinch rollers and ready the 
machine. 

9. Set Send Mode to Contour Only. 

10. Click the Send button to send the contour cut to the 
device. The device will then cut the contour, automatically 
compensating for any media skew 

Using a VersaCAMM as a Virtual Hybrid 
To print a job on another device and use a VersaCAMM as a 
cutter: 

11. When printing the job: 

a. Select the VersaCAMM as the cutter. 

b. Set Registration mark to Roland VersaCAMM. 

 If you are using PhotoPRINT, the software automatically adds the 
appropriate registration marks to the job when you select the output 
device in the Workflow tab of Job Properties. 

c. Set Send to Print job only. 

12. Print the job. The print out should look similar to the image 
below, with black circles and crop marks added by the 
printer. 

 
13. Remove the media from the printer. 

14. Load the media in the VersaCAMM. 

15. Set Send Mode to Contour Only. 

16. Click Send. The device will automatically detect the 
alignment marks and cut the contour. 
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Summa OPOS 

Automatic Positioning Using OPOS Marks 
To cut a contour using the Summa cutters: 

1. If you will be running the Summa cutter off of USB, install 
the Summa USB Drivers.  

2. Add a setup for the cutter to PhotoPRINT or Production 
Manager. 

3. Depending on the application, do the following: 

• In PhotoPRINT, add the job and open Job Properties. 

• In Flexi, design the job and open the RIP and Print 
dialog. 

4. Set Registration Mark to OPOS. 

5. Print the job and load the printed output into the cutter. 

6. Send the cut job. 

7. Line up the cutter with the OPOS mark: 

 
a. Use the cutter’s arrow keys to move the sensor head 

(Not the pen/knife!) over the lower right OPOS mark. 

 
b. Press the Enter  button on the cutter. 

The cutter will detect the marks, and then cut the contours. 
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